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Overview of the Q-Box AQUA Aquatic Respirometry Package

The Q-Box AQUA is used to measure metabolic rate in resting aquatic animals using
intermittent closed respirometry, in which measurements are made sequentially without
removing the animal from the sample chamber. The system is used for measuring the decrease
in dissolved oxygen (DO) due to respiration by fish or other aquatic animals. The oxygen
consumption of the animal (VO2), is calculated from the rate of DO decline. The chamber is
flushed between measurements with fresh water from the bath in which the chamber is
submersed. This intermittent method overcomes the disadvantage of continuous closed
respirometry in which the DO level in the chamber continually decreases. This decrease may
stress the animal physiologically during extended experiments.

The diagram below shows the set up of a Q-Box AQUA system. Tubing for water flow is shown
in blue (solid lines indicate flow; broken lines indicate no flow), whereas black lines indicate
electrical connections. The components include two respirometer chambers (small and large),
a 3-way valve controlled by the digital control unit (DCU), a DO probe held in a flow through
vessel, and a liquid pump. All components are connected with tubing. During an experiment,
the animal is placed in the chamber which is immersed in a water bath. In the “flush” mode, the
3-way valve is in the de-energized state where the loop is open. The pump then draws water
from the bath to flush the chamber with fully oxygenated water under ambient conditions. The
water returns to the bath from the chamber via the open portion of the T-piece between the
chamber and the 3-way valve. Temperature, dissolved oxygen, pH etc. can also be controlled in
the water bath with optional components. Contact Qubit Systems for these options.

During the measurement or “circulation” phase, the 3-way valve is energized to close the loop
so that the pump circulates water through the closed system as shown by the solid blue lines. In
this circulation phase, DO declines in the closed loop as the animal consumes O,. From the rate
of decline (i.e. the slope of the DO trace) the respiratory O, consumption (VO2) can be
calculated. The flush-circulation cycle is repeated until the experiment is terminated. A VO2
value is automatically calculated from each circulation period.

With short periods of intermittent closed loop respirometry, build-up of waste products and
severe depletion of dissolved oxygen are avoided. The intermittent method facilitates dynamic
studies of VO2 with a time resolution of a cycle time (i.e. flush plus circulation time) which is
selected by the user in the software. The flush time should be sufficient to restore the DO level
to that of the external water bath, whereas the circulation time should be long enough to
obtain an accurate slope of the DO decline. The depletion of O, during the measurement period
should be kept to a minimum (< 10%) but will depend on the tolerance of the animal to
hypoxia. The ratio of chamber volume to animal volume should be 10 - 20 for resting studies.
Therefore, the standard Q-Box AQUA system will work well with animals that are minimum of 7
(small respirometer chamber) or 30 g (larger respirometer chamber) in size. Optional custom
size respirometer chambers for larger animals are also available.



The dissolved oxygen is measured with an optical dissolved oxygen probe (5122). This probe is
internally compensated for changes in both temperature (with a thermistor) and pressure (with
a pressure sensor). These two parameters affect oxygen solubility in water as well as oxygen
diffusion through the probe membrane. Therefore, the sensor may be used at different
temperatures and pressures from those at the time of the original factory calibration or
recalibration by the user.

Three additional sensors included in this package are a salinity probe (S130) for measuring
dissolved salts (which affect oxygen solubility), a stainless-steel temperature probe (5132) for
monitoring water temperature and an absolute pressure sensor for measuring atmospheric
pressure. The optical dissolved oxygen probe maintains its calibration for long periods.
However, if calibration becomes necessary, the measured temperature and pressure are
required for determining the absolute air-saturated DO level in units of mg/ml. Correction for
salinity is calculated in the software using the measured salinity data. An additional analog
signal comes from the liquid pump PL1775. This signal is corelated with the flow rate of water
through the system but is different for every setup. The user may monitor this voltage output
at a specific flow rate during an experiment and for future experimental setups.

The five analog signals from the sensors are digitized with 2 LabQuest Mini interfaces (3-
channel, 12-bit). Data is recorded, displayed, and manipulated on a PC or Macintosh computer
using Logger Pro software.



Q-Box Aqua Setup

Figure A: Open (Flush) State

Note: solid blue lines indicate water flow, broken blue lines indicate no flow, black lines indicate
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Figure B: Closed (Circulation) State
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During the flush mode, intake of fresh water from the water bath, and output of water leaving
the respirometer chamber and returning to the bath, is shown by blue arrows in the photo
below.

In the photograph below, the direction of water flow during circulation, is shown by blue
arrows.



Components of the Q-Box AQUA:
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Small Respirometer chamber (G216: 3.84 cm ID, 15.3 cm long, vol. with end caps, 140 ml)
Large Respirometer chamber (G217: 8.2 cm ID, 16.7 cm long, vol. with end caps, 660 ml)
Salinity Probe for the water bath (5130)

Temperature probe for the water bath (5132)

Digital Control Unit (DCU) for control of 3-way valve (C200)

Data Acquisition Interface (C610 LabQuest Mini) x2

Three-way valve to switch between flush and circulation (A236)

Absolute Pressure Sensor (5181)

Flow-through vessel for DO Probe (A260)

. Optical DO Probe (5122)

. Liquid Pump (1 L/min max) (PL175) with analog output

. Water filter

. Q-Box AQUA Kit (tubing 1/4” ID, quick release connectors, extra filters for the chambers)
. Logger Pro Data acquisition software (C901) and custom experimental files (C404)

. Water Bath

. Manual

. Rugged Q-Box case for storage and transport of all components.



The Q-Box AQUA components are supplied in a rugged Q-Box case for easy storage and transport.
Two layers of foam hold the components. It is important to dry all wet components after each
use before placing them back in the case.

Start Up Steps:

1. The system is provided partially assembled with pre-cut tubing (1/4" ID) in place.
Assemble the system as shown in the photo and diagram above (pages 5-8). If a different
set up is required, cut and connect tubing between the components as shown in the
above system diagram or as in the photograph. Keep in mind that the longer the tubing,
the larger the volume of the system (and hence lower sensitivity) so ensure the tubing
between the components is as short as the set up will allow. As supplied, the volume of
the system external to the chamber (i.e. tubing, pump, 3-way valve and flow through
vessel) is approximately 75 ml but it should be measured for each system for accurate
number. When filling the water bath with water it is important to ensure that the
temperature of the water is maintained as constant as possible and if it is significantly
different from air temperature then any tubing external of the water bath that carries
water between the pump, valve and the chamber is insulated to prevent heat transfer
between the water and the atmosphere. Small changes in water temperature will result
in significant changes in DO concentrations. Insulation of the water bath is also
recommended. Maintaining the DO probe and the flow through vessel in the water bath
during measurements ensure that the temperature of the water next to DO probe is
maintained constant and the same as that in the respirometer.

The photo of the 3-way valve is shown below. Ensure that the tubing is connected as
indicated. The intake from the water bath during flush mode is shown with blue arrows.



From DO probe vessel

(intake during /
circulation)
From the water bath

/ (intake during flush)

Outflow to Pump

~

2. Connect the LabQuest Mini interfaces to the computer with the supplied USB cables.

3. Connect the DCU unit to the Dig 1 port on the LabQuest Mini 1 interface via the white
BTA connector. Connect the 3-way valve (A236) cable to the DCU unit via the D1 input.
Power the DCU unit via the power supply provided.

4. Place the DO probe in the flow-through vessel and connect the output cable to channel 1
of the LabQuest Mini 1 interface.
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5.

6.

Ensure that the DO probe is placed in the flow through vessel deep enough so that the
thermistor used for temperature compensation (silver dot), is submerged in the water
flowing through the vessel (see photo below). The inlet flow past the bottom of the probe
should prevent bubbles from collecting on the bottom, which would affect the DO
readings. Any bubbles that collect at the top of the vessel may be voided by tipping the
vessel so that the bubbles escape through the outlet at the top with stopper removed.
Ensure that the locking nut at the top of the vessel is tightly closed around the probe to
prevent leaks. Place the flow through vessel in the water bath so temperature of DO
probe is the same as that of the chamber with animal.

AN

Connect the Salinity probe (S130) to channel 2 of LabQuest Mini 1. The salinity probe is
placed in the water bath to measure water salinity which is used in Logger Pro software
to correct the measured DO for salt content. Do not completely submerge the sensor but
ensure the electrodes are submerged.

Connect the Temperature Sensor (S132) to channel 3 of the LabQuest Mini 1 to measure
water temperature of the bath. This is required for calibration. Place the sensor in the
bath but do not completely submerge the sensor.

Connect the Pressure sensor (S181) to channel 1 of the LabQuest Mini 2 to measure
atmospheric pressure and connect it to its power supply. Atmospheric pressure is
required for calibration of the DO probe. Do not place this sensor near water and do not
submerge the sensor in water.

11



9. Connect the voltage output cable from the PL175 pump to channel 2 of LabQuest Mini 2

10. Once the system is set up, place the respirometer chamber and the DO probe inside the
flow through vessel in the water bath. Fill the bath with air-saturated water to a depth at
which the chambers are fully submerged. There should be enough water in the bath so
that when the chamber is being manipulated during opening and closing of the end caps,
air will not be introduced into the chamber. Air equilibrated water can be obtained by
bubbling with an air stone or by leaving the water exposed to air for several hours. If
necessary when using large fish with high O, consumption, full oxygen saturation of the
water in the bath may need to be maintained by bubbling the water in the bath with air.
The volume of water in the bath should be large enough to buffer any changes in water
temperature. And to completely cover the aquatic chamber and the DO vessel. Fill the
system with water by opening the chamber (pull off the inlet cap and disconnect the inlet
tubing to avoid pulling a vacuum inside the system). The photo of the system with the
water bath in place is shown below.

11. In both chambers, note the locking screws on either side of the end caps. These should
be connected via small holes in the chamber tubing and lined up with the outer groove in
the end cap and tightened to prevent the end caps from disengaging under pressure of
water flow. Ensure the screws fit into the grooves and do not press against the end cap
outside of the groove as this will distort the chamber and result in a leak.

12
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12. Also note the presence of a circular filter at the outlet of the chamber. This is to prevent
any debris from the animal entering the system and possibly plugging the 3-way valve or
the liquid pump. Check this filter at the end of each experiment and clean it well. This
filter may be replaced by unscrewing the end baffle first and removing the old filter.
New filter (included in the accessories kit) may be attached.

vent
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13.

14.

15.

Attach the liquid pump output to the animal chamber. Turn on the pump and set the flow
of water through the respirometer during flush using the speed control on the pump. The
flow can be set by timing the collection of a measured volume via the flush outlet (on the
T-piece after the chamber). The maximum speed of the pump when connected to the
system is approximately 1 L/min. When setting up the large respirometer chamber, start
with low flow while getting rid of the air bubbles and filling the system with water. Then
lock the end caps in place with the locking screws and increase the flow to the desired
rate. A flow of about 300-400 ml/min is optimal when using the large chamber. When
using the small chamber, a flow of about 200-250ml/min is optimal. The flow determines
the "washout" time (and thereby time response) for the system. Normally an exchange
of five system volumes is considered sufficient for washout or exchange of water during
flushing. The liquid pump comes with analog output cable. This cable should be
connected to channel 2 on LabQuest Mini 2 and the flow rate measured may be correlated
to voltage output. Please note that the voltage output will differ with each setup.

During set up, bubbles of air may need to be released from the closed system. First with
the pump running, get rid of bubbles in the probe vessel by tipping the probe so the
bubbles escape through the outlet. These bubbles will then flow through the system and
collect in the chamber. Next remove the stopper from the vent on the top of the chamber
(see photos above on pg. 13) and tip the chamber to release the bubbles. Ensure there
are no bubbles trapped in the chamber, the DO probe vessel or tubing before starting
experiments. Tipping the liquid pump upside down briefly and tapping it will also release
any bubbles that may get trapped. Let the system run through a few Flush/Circulation
cycles while collecting data and monitoring the DO levels. This data with an empty
chamber will indicate DO stability and background levels of DO in the water.

After collecting data with an empty chamber, the software may be left running as a
specimen is loaded into the chamber. Ensure the stopper in the vent on top of the

14



16.

17.

18.

chamber is removed when opening and closing the chamber to avoid pressurizing the
chamber and damaging the animal. Close the vent before collecting data with the animal.

The “active” volume of the respirometer during closed circulation is required for the VO2
calculation on Page 2 in Logger Pro. This volume is measured by filling the entire system
with water during circulation. Then using the pump, this volume is emptied into a
graduated cylinder. To completely drain the pump, tubing, and valves, disconnect the
tubing and shake or blow out the water. The volume of water in the flush inlet and outlet
tubes (see system diagram on page 5) should be subtracted, since the water in these tubes
is not available to the animal during circulation. To calculate the volume of the 1/4” tubing
use the 0.334ml/cm conversion. The total active volume of the respirometer is used in
the calculations of VO2 on Page. 2 of the Experiment file and is entered on page 3 in the
user parameters as “RespirVol”.

Load Logger Pro 3 software on the computer and Load C404 customized files as per the
instructions on pages 36 and 37 before DO data can be monitored.

Open the “Q-Box AQUA Setup” file to start Logger Pro software. The sensor confirmation
window will appear.

15



19. Three sensors are auto-detected: Optical DO probe, salinity and temperature probes in
analog input channels 1, 2 and 3, respectively of LabQuest Mini 1. Select "Qubit Systems
g-S181 Absolute Pressure Sensor for channel 1 of LabQuest Mini 2 and raw voltage for
Flow voltage output in channel 2 of LabQuest Mini2. A text box indicating the sensor
connections to LabQuest Minis is included on Page 1 of the” Q-Box AQUA Setup” file.

Sensor Connections

Mini 1:

DO (autodetect) CH1
Salinity (autodetect) CH2
Temperatur (autodetect) CH3
DCU DIG1
Mini 2:

Pressure CH1
PL175 Flow (V) CH2

20. The optical DO probe is both temperature and atmospheric pressure compensated. It is
supplied with factory calibration and it normally does not require re-calibration. However,
if DO values do not appear to be correct or stable, a recalibration of the optical DO probe
should be done. The calibration procedure is provided on page 29.

21. Once all sensors are connected the following initial screen will appear:

16



22. Before starting to collect data, set up the experiment length and sample rate by selecting
Experiment>Data Collection in the main menu, or by clicking on the clock icon of the top
menu.

« o

The following dialog box will appear:

17



23.

Input experiment length and data sampling rate as required. The default is 1 sample per
second. Click “Done”.

Set the length of the rest (initial acclimatisation), flush and circulation times on Page 3 of
the “Q-Box AQUA Setup” file —in “User Parameters” as described below on page 24. The
circulation time should be long enough to obtain sufficient decline in DO for an accurate
slope determination. However, the decline in DO should not reach levels that can stress
the animal. The flush time needs only to be long enough to restore the DO concentration
in the chamber to the fully oxygenated level in the bath. The default is 5 min for circulation
and 3 min for flush. The MeasureFraction user parameter sets the fraction of
MeasureTime for calculations of the VO2 rate. This is set by default to 0.75 and should
not be changed unless the data obtained during the MeasureTime (circulation) is in the
latter portion of the period. RespirVol, SpecimenVol and SpecimenWeight user
parameters also need to be set and these depend on the system that is used and the size
of the animal. The user parameter BackgroundVO2 should be set to 0 when initially
collecting the data. This parameter allows for correction of the VO2 rates once data
collection is completed if background decline in DO level was measured with an empty
chamber before the animal was placed in it. Background slopes in DO are likely due to
respiration from contaminants — bacteria, fungi, sample slime etc. Keeping the chamber
and all the tubing clean is therefore important to minimize any contamination. The screen
shot of page 3 — User Parameters of the experimental file is shown below.

18



24, Start data collection by clicking the green button “Collect” and stop data collection by
clicking the red “Stop” button (green turns red during data collection).

~

25. During an experiment, the range of x and y axes on graphs can be adjusted by clicking on
the lowest or highest number and typing in the desired new value. Other graph options
(auto scaling, strip charting, selection of variables plotted etc.) can be controlled by
selecting the graph (double clicking on the graph) and selecting “Axes Options” menu.

19



26. Save the file under a new name using the commands File>Save As so as not overwrite the
original “Q-Box Aqua Setup” file.

Logger Pro Data Analysis:

Upon completion of the experiment, the data can be analyzed in Logger Pro using various
analysis tools (e.g. examine, slope, statistics, integral etc.) in the “Analyze” menu, or by
clicking on the analysis icons in the top menu bar. To select the raw data for analysis,
depress the left mouse button and drag the cursor across the data of interest in the graph.
Select the analysis tool required. The Help menu provides extensive instructions for Logger
Pro analysis functions.

e
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The rate of respiration in mg0,/L/sec for every circulation cycle is automatically calculated
directly from the slope of the DO decline as recorded during circulation cycles and displayed
in the sample data graph. The data can also be directly exported (File>Export As>CSV), and
can then be opened in Excel for further analysis and calculations.

Sample Data:

Sample data from an experiment with a large goldfish (in a large respirometer chamber) are
shown below.

N\

The Logger Pro “Q-Box AQUA Setup” file consists of 3 pages: 'Page 1 - Raw Data’, 'Page 2 - VO2
Calculations', 'Page 3 - User Parameters'. A specific page selected by the “Page” command

from

the main menu or from the drop-down menu in the tool bar, as shown in the window

above.

a.

Page 1 as shown above with the sample data is the ‘Raw Data’ page. These data are
presented in a table, in graphs and in meters. Logger Pro is a very powerful and user
friendly software, so the user can easily customize the graphs, meters or column
calculations by double clicking on them and manipulating the available options or
calculation equations. It is highly recommended that any modifications to the
Experiment File be saved under a new name to preserve the original unaltered file.
Select: File>Save As to save the experiment settings under a new file name.

21



The sample data from a large goldfish shown above was collected during successive
recirculation and flush cycles. The time course of the flush and circulation phases is
indicated by the red PWM (pulse width modulated) trace which has a value of “0”
during flush and a value of “1” during circulation.

Page 2 is the ‘VO2 Calculations’ page and it includes a table with calculations of oxygen
consumption (VO) in mg0,/kg/hr made automatically at the end of each closed
circulation (i.e. measuring phase). The text box at the top of Page 2 explains the
calculation of VO2 from the DOSlope. The slope for each circulation is calculated only
during the latter 75% of the circulation phase (i.e. constant slope) has been reached
after switching from flush (open) to circulation (closed). This fraction of the
measurement time used in the slope calculation can be adjusted by the user via the
"MeasureFraction" user parameter on Page 3 (see print screen of page 3 from the
experimental file above on pg. 17 of the manual). This is only recommended if shorter
period is required due to unstable or noisy data in the first part of the measurement
time. Otherwise, the MeasureFraction parameter should be left at its default setting of
0.75.

22



In addition to the DOSlope, the calculation needs the volume, Vr, (L) of the respirometer
system which includes the chamber plus all of the other components such as tubing,
flow-through vessel holding the DO probe, 3-way valve and liquid pump (see step #12 in
Start up Steps on how to obtain the Respirometer volume). The Specimen volume, Va,
(L) and specimen weight, m, (kg) are also needed. The volume of the specimen can be
measured by placing the fish in a graduated cylinder with a known volume of water and
measuring the displacement of that water. The weight of the specimen can be obtained
by weighing the graduated cylinder with and without the fish or by calculating the
weight from the fish volume assuming a density of 1g/ml. The respirometer volume,
specimen volume and specimen weight are entered as user parameters on Page 3 (see
below). The VO2in mg0,/kg/hr is calculated automatically at the end of each circulation
on Page 2 as:

VO, = DOSlope*(Vr-Va)*60/m

VO2=oxygen consumption (mg Oz/kg/hour)
DOSlope=rate of decrease of DO (mg O2/L/min)
Vr=respirometer volume (L);
0.735 L - with large chamber, 0.215 L - with small chamber
m=animal mass (kg)

Page 3: The third page of the Logger Pro Experiment File shows “User Parameters”. This is
where the user enters the length of time for the Rest — RestTime (initial adaptation period),
Circulation — MeasureTime (measurement) and Flush — FlushTime (renewal) periods. Also
the total respirometer volume — RespirVol, as well as animal volume — SpecimenVol and
weight — SpecimenWeight can be entered here. Finally, the fraction of the DO data
obtained during circulation and used for slope calculation can be entered in the
MeasureFraction parameter.
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The value of a user parameter can be changed by toggling the up and down arrows in the
meter, or by double clicking on the meter and inputting the required value as shown below.

User Parameters

- - Parameter Control Options _ 2
T .
R e S t I m - o
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O S Font:
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st
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FlushTime | =5 =&

i‘ [ ree | [ ok | cancel
ANMN -~

Default values are provided. Most of the User Parameter values should be entered before
the start of the experiment and not while the experiment is running. If user parameters
are changed while an experiment is running this change will be applied to previously
collected data. The RespirVOI, SpecimenVol, SpecimenWeight can all be entered after the
completion of the experiment and the VO2 data will be recalculated.

An additional User parameter BackgroundVO2 is provided in the experimental file to
correct the VO2 data for any background DO slopes that may be present when no specimen
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is inside the respirometer chamber. These background slopes are mainly due to
contaminants either in the water or in the system often following the experiment and
removal of the fish. It is therefore important to keep the system clean and the water clean.
If the background slope is present it can be easily removed from the data obtained with the
specimen present in the chamber by following these steps:

a. Setthe BackgroundVO2 to zero before start of the experiment to determine the
actual BackgroundVO2 from the collected data.

b. Proceed with the experiment and collect the data. If background slope in DO is
observed, upon completion go to page 2 — VO2 calculations and determine the
average background VO2 by highlighting with the mouse VO2 values when no
specimen was present in the chamber (see image below) and click on the statistics
icon in the top menu or select “Statistics” from “Analyze” drop down menu. The
mean value for background DO is shown in the statistics window (34 in the example
below).

c. Enter the value of background VO2 in the user parameter BacgroundVO?2 of page 3 as
shown below
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d. Corrected VO2 data for background slope will be automatically displayed on page 2
in the VO2 graph:
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Optical DO Probe:

Principles of Use:

The Q-Box AQUA system employs an optical DO probe as shown in the following diagram. This
type of DO probe is based on reversible quenching of both the intensity and lifetime of
luminescence in a dye when oxygen is present. The probe cap encases the dye in a protective
matrix which is permeable to oxygen diffusing from the water in which the probe is submersed.
The intensity and lifetime are inversely related to the oxygen partial pressure in the water. This
is a nonlinear relationship. Unlike Clark electrochemical sensors (both polarographic and
galvanic) optical DO sensors do not consume oxygen and hence do not require liquid stirring. Also
optical DO probes require much less frequent calibration than electrochemical sensors due to
long term stability of the dye. They do not require filling with electrolyte solution and do not
require warm-up like polarographic probes.

A blue LED excites the dye to a higher energy level. Collisions of oxygen molecules with the
excited dye molecules transfer energy to the oxygen and cause the dye to emit longer wavelength
red light. Although the luminescence intensity (i.e. red) is increased, a more stable signal is
achieved by measuring the decrease in lifetime of the excited state in the dye caused by oxygen.
Lifetime is not affected as much as intensity by bleaching or photo degradation of the dye over
time. This lifetime is measured as the time between an excitation pulse from the blue LED and
detection of the emitted red light by a photodiode. With more oxygen present, less time is
required for the red light emission. Hence the lifetime decrease provides a measure of the partial
pressure of oxygen in the water. Red LED flashes between the blue LED flashes, provide a
reference reading.

A thermistor located in the DO probe automatically compensates for temperature changes,
which affect both diffusion of oxygen through the cap as well as solubility of oxygen in water. The
thermistor is the round silver metal spot near the probe tip, and it should be immersed to ensure
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correct sensing of the water temperature. The probe also contains a pressure sensor which
compensates for pressure changes due to altitude, weather or water depth, since oxygen
diffusion and solubility is also dependent on the partial pressure of oxygen. Consequently, the
probe can be used at temperatures and pressures other that those during the original factory
calibration or recalibration by the user.

The probe may be completely submerged to ~ 1.5 m (up to the box in the cable). An optional
metal guard is available to protect the cap from damage and also to weigh down the buoyant
probe for depth measurements.

Units of % (DO level relative to fully oxygenated water) or mg/L (absolute units of oxygen per liter
of water) may be selected on the box in the cable. Please note that the experimental file is set
up for use of the DO probe in mg/L units and a change to % saturation will require a new
experimental setup.

/

The solubility of oxygen is dependent on temperature and pressure as shown in Table 1. Salinity
also affects solubility as shown in Table 2. Solubility will be discussed further in the following
Calibration section.

DO Probe Storage and Maintenance:

After use, dry the probe top with a tissue. Store the probe in the storage tube with a damp sponge
in the bottom.
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The probe cap containing the matrix and dye is replaceable. Avoid direct sunlight to prevent
bleaching and reduced lifetime. Increased noise or a decrease in sensitivity indicates replacement
is necessary. The caps are individually calibrated at the factory, therefore replacement caps are
supplied with a microSD card containing the unique calibration code. To replace the cap and card:

e disconnect the probe from the data interface

e remove the screw from the microSD cover on the box in the probe cable and replace the
card

e unscrew the cap from the probe tip and replace with the new one

e Toreset the calibration: set the units switch to %

e connect the probe to the LabQuest Mini and start Logger Pro

e add water to wet the sponge in the storage tube

e place the probe in the storage tube for at least 1 minute so the air becomes 100%
saturated with water vapour

e press the reset button on the bottom of the microSD box for 3 seconds using a paper clip

e release the button - the reading should drop to 0%

e wait for the reading to change to 100% - this may take ~ 1 minute

DO Probe Calibration:

The optical DO probe does not require frequent calibration, however if necessary, a calibration
procedure is provided as follows. Since the probe is nonlinear, it is calibrated at one known DO
level (i.e. single point calibration) by using air-saturated water or, alternatively, water saturated
air (100%). Water saturated with oxygen can be obtained by bubbling air through water, or by
leaving water exposed to air for several hours. A more rapid method is to use air saturated with
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water vapour. This is obtained by wetting the sponge in the protective probe storage holder,
inserting the probe in the holder and waiting ~ 1 minute. The calibration units can be mgO2/L, or
% air saturation, depending on the switch position on the box in the probe cable. Since the DO
electrode is compensated for temperature, and pressure, the calibration performed in the lab (or
at the factory) will be valid at other temperatures and pressures. The probe is not internally
compensated for salinity. Therefore, salinity measurements provided by the salinity probe (S130)
are used to correct the DO values in Logger Pro - see Salinity Correction for Measured DO on page
30.

DO probe calibration steps:

1. Load the “Q-Box AQUA Setup” file and ensure that the Dissolved Oxygen Probe is plugged
into channel 1 of the LabQuest Mini 1 Interface.

2. A one-point calibration is initiated by the LoggerPro commands:
Experiment>Calibrate>LabQuest Mini: 1 CH1: Optical DO Probe. The following dialog box
will open.

3. Check the box for "one point" calibration.

4.  Ensure that the calibration storage is selected with the “Experiment file” if calibration is to
be stored with the experiment
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10.

Sensor Settings £

Sensor Info | Calibrate I Equation | Calibration Storage

LabQuest Mini: 1 CH1: Optical DO Current Calibration:
Probe
Dissolved Oxygen mg/L <ExperimentF

Set Sensor Calibration J I Set Sensor Factory Defaults I \

Sensor Default Page: IPage 0 {mg/L) -

Calibration Retrieval Preference:

When this experiment file is opened, get this sensor's calibration from:
~) 5ensar (calibration stored on sensor)

~) Computer (calibration stored on this computer)

@) Experiment File (calibration stored with the current document)

[ Daone ]l Cancel I

Alternatively, the new calibration may be stored on the sensor once it has been
completed (see below).

Select Calibrate>Calibrate Now as shown in the above Sensor Settings window. The
voltage output from the DO probe will be shown.

Place the probe in fully oxygenated water or in the storage tube with a wet sponge.

The voltage output from the DO electrode should stabilize at ~ 2 V. Enter as ‘Reading 1’, the
appropriate value for DO of air-saturated water, at the temperature of the water bath
measured by the S132 temperature probe, and at the atmospheric pressure measured by
the S181 absolute pressure sensor. This value for DO in absolute units of mg/L is obtained
from Table 1 below. Then click on ‘Keep’. For example, at 20 °C and 760mmHg (101.325
kPa) this concentration is 9.17 mg02/L, as shown in Table 1. Data from Table 1 is plotted in
Figure 1 indicating the temperature dependence of DO at a constant pressure (more oxygen
dissolves in water open to the air as the temperature decreases).

Select Equation>Options from the Sensor Settings window menu and record the Slope and
Intercept values for future reference.

If storing the calibration on the sensor, select in the calibration storage as “sensor” and
press “Done”

Sensor Info Calibrate Equation Calibration Storage

LabQuest Mini: 1 CH1: Optical DO Current Calibration:
Probe

Dissolved Oxygen mg/L <Sensor Page 1

Set Sensor Calibration Set Sensor Factory Defaults

Sensor Default Page:  Page 0 (mg/L) i

Calibration Retrieval Preference:
When this experiment file is opened, get this sensor's calibration from:

@ Sensor (calibration stored on sensor)
O Computer (calibration stored on this computer)

() Experiment File (calibration stored with the current document)
Press "Done" to write changes to sensor, or press "Cancel” to discard all changes.

Help Done Cancel
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11.

12.

A window will appear where the user selects replacement of the previous calibration and
confirms to apply the changes.

Warning: You are about to change information in your sensor. Configuration
data stored on the sensor will be lost. Pressing "Write" will apply your changes
to the sensor.

Write Cancel

When calibration is complete, click ‘Done’. The DO electrode is now calibrated. Save the
file under a new name if you wish to save the calibration with the experimental file.

Note: Since the probe is temperature and atmospheric pressure compensated internally,
it can be used at temperature and pressures different from those present during
calibration.

Please note that temperature has a large effect on the solubility of 02 and therefore Do

concentration in the water. As a result, it is important to maintain the temperature
constant during experiments.
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Table 1: Dissolved 02 (mg/L) in air-saturated distilled water (at various temperatures (°C) and

atmospheric pressures (mmHg/kPa))

770/ 760/ | 750/ | 740/ | 730/ | 720/ | 710/ | 700/ | 690/ | 680/ | 670/ | 660/ | 650/

102.658 101.325/99.992 | 98.659 | 97.325 | 95.992 | 94.659 | 93.326 | 91.992 | 90.659 | 89.326 | 87.993 | 86.659
0°C | 14.76 | 14.57 | 14.38 | 14.19 | 13.99 | 13.80 | 13.61 | 13.42 | 13.23 | 13.04 | 12.84 | 12.65 | 12.46
1°C | 14.38 | 14.19 | 14.00 | 13.82 | 13.63 | 13.44 | 13.26 | 13.07 | 12.88 | 12.70 | 12.51 | 12.32 | 12.14
2°C | 14.01 | 13.82 | 13.64 | 13.46 | 13.28 | 13.10 | 12.92 | 12.73 | 12,55 | 12.37 | 12.19 | 12.01 | 11.82
3°C | 13.65 | 13.47 | 13.29 | 13.12 | 12.94 | 12.76 | 12.59 | 12.41 | 12.23 | 12.05 | 11.88 | 11.70 | 11.52
4°C | 13.31 | 13.13 | 12.96 | 12.79 | 12.61 | 12.44 | 12.27 | 12.10 | 11.92 | 11.75 | 11.58 | 11.40 | 11.23
5°C | 12.97 | 12.81 | 12.64 | 12.47 | 12.30 | 12.13 | 11.96 | 11.80 | 11.63 | 11.46 | 11.29 | 11.12 | 10.95
6°C | 12.66 | 12.49 | 12.33 | 12.16 | 12.00 | 11.83 | 11.67 | 11.51 | 11.34 | 11.18 | 11.01 | 10.85 | 10.68
7°C | 12.35 | 12.19 | 12.03 | 11.87 | 11.71 | 11.55 | 11.39 | 11.23 | 11.07 | 10.91 | 10.75 | 10.59 | 10.42
8°C | 12.05 | 11.90 | 11.74 | 11.58 | 11.43 | 11.27 | 11.11 | 10.96 | 10.80 | 10.65 | 10.49 | 10.33 | 10.18
9°C | 11.77 | 11.62 | 11.46 | 11.31 | 11.16 | 11.01 | 10.85 | 10.70 | 10.55 | 10.39 | 10.24 | 10.09 | 9.94
10°C | 11.50 | 11.35 | 11.20 | 11.05 | 10.90 | 10.75 | 10.60 | 10.45 | 10.30 | 10.15 | 10.00 | 9.86 9.71
11°C | 11.24 | 11.09 | 10.94 | 10.80 | 10.65 | 10.51 | 10.36 | 10.21 | 10.07 | 9.92 9.78 9.63 9.48
12°C | 10.98 | 10.84 | 10.70 | 10.56 | 10.41 | 10.27 | 10.13 | 9.99 9.84 | 9.70 9.56 9.41 9.27
13°C | 10.74 | 10.60 | 10.46 | 10.32 | 10.18 | 10.04 | 9.90 9.77 | 9.63 9.49 9.35 9.21 9.07
14°C | 10.51 | 10.37 | 10.24 | 10.10 | 9.96 9.83 9.69 9.55 9.42 9.28 9.14 | 9.01 8.87
15°C | 10.29 | 10.15 | 10.02 | 9.88 9.75 9.62 9.48 9.35 9.22 9.08 8.95 8.82 8.68
16°C | 10.07 | 9.94 9.81 9.68 9.55 9.42 9.29 9.15 9.02 8.89 8.76 8.63 8.50
17°C | 9.86 9.74 9.61 9.48 9.35 9.22 9.10 897 | 884 | 871 8.58 8.45 8.33
18°C | 9.67 9.54 9.41 9.29 9.16 9.04 | 891 8.79 8.66 | 8.54 8.41 8.28 8.16
19°C | 9.47 9.35 9.23 9.11 8.98 8.86 8.74 | 8.61 8.49 8.37 8.24 | 8.12 8.00
20°C | 9.29 9.17 9.05 8.93 8.81 8.69 8.57 8.45 8.33 8.20 8.08 7.96 7.84
21°C | 9.11 9.00 8.88 | 8.76 8.64 | 8.52 8.40 8.28 | 8.17 | 8.05 7.93 7.81 7.69
22°C | 8.94 8.83 8.71 8.59 8.48 8.36 8.25 8.13 8.01 7.90 7.78 7.67 7.55
23°C | 8.78 8.66 8.55 8.44 8.32 8.21 8.09 7.98 7.87 7.75 7.64 | 7.52 7.41
24°C | 8.62 8.51 8.40 | 8.28 8.17 8.06 7.95 7.84 7.72 7.61 7.50 | 7.39 7.28
25°C | 8.47 8.36 8.25 8.14 8.03 7.92 7.81 7.70 7.59 7.48 7.37 7.26 7.15
26°C | 8.32 8.21 8.10 | 7.99 7.89 7.78 7.67 7.56 7.45 7.35 7.24 | 7.13 7.02
27°C | 8.17 8.07 7.96 | 7.86 7.75 7.64 | 7.54 7.43 7.33 7.22 7.11 7.01 6.90
28°C | 8.04 7.93 7.83 7.72 7.62 7.51 7.41 7.30 7.20 7.10 6.99 6.89 6.78
29°C | 7.90 7.80 7.69 7.59 7.49 7.39 7.28 7.18 7.08 6.98 6.87 6.77 6.67
30°C | 7.77 7.67 7.57 7.47 7.36 7.26 7.16 7.06 6.96 6.86 6.76 6.66 6.56
31°C | 7.64 7.54 7.44 | 7.34 7.24 | 714 | 7.04 6.94 6.85 6.75 6.65 6.55 6.45
32°C | 7.51 7.42 7.32 7.22 7.12 7.03 6.93 6.83 6.73 6.63 6.54 | 6.44 | 6.34
33°C | 7.39 7.29 7.20 7.10 7.01 6.91 6.81 6.72 6.62 6.53 6.43 6.33 6.24
34°C | 7.27 7.17 7.08 6.98 6.89 6.80 6.70 6.61 6.51 6.42 6.32 6.23 6.13
35°C | 7.15 7.05 6.96 6.87 6.78 6.68 6.59 6.50 6.40 6.31 6.22 6.13 6.03
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Figure 1: Temperature Dependence of DO in Water at 760 mm Pressure
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Salinity Correction for Measured DO

The calculations on Page 2 of the “Q-Box AQUA Setup” file are for DO in mg(02)/L(H20).
Calibration in these absolute units (mg/L) requires consideration of temperature, pressure and
salinity. As discussed above, when calibrating the dissolved oxygen probe in units of mg/L use
the dissolved oxygen concentration in Table 1 that corresponds to the air-saturated value at the
temperature and pressure during calibration. The temperature readings are obtained from the
temperature probe (S132) and air pressure readings are obtained from the absolute pressure
sensor (S181). Since the DO probe includes internal temperature and pressure compensation,
once it is calibrated, a change in temperature or pressure is automatically accounted for when
the units setting on the probe is absolute (i.e. mg/L).

Salinity significantly affects the solubility of oxygen in water. Seawater has a salinity of ~ 35 ppt,
and at 20°C and 760 mm pressure, has ~ 19% lower DO compared to freshwater at the same
temperature and pressure. The probe does not internally compensate for salinity, hence, the
salinity correction to the DO measured by the optical DO probe is corrected in Logger Pro
software using the salinity measured by the $130 salinity probe.
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Dissolved O, concentration for air-saturated water at various salt concentrations, DOcor, can be
calculated using the formula:
DOcor = DO-k*S (1)

Where, DOcor is the corrected concentration of dissolved oxygen (mg/L) in salt water solutions,
DO is the dissolved oxygen concentration measured by the optical probe (T and P compensated),
Sis the salt concentration (ppt), measured by the S180 salinity probe and k (1/ppt) is a constant.
The value of k varies according to the water temperature as shown in Table 2:

Note: At salinity levels less than 1 ppt, neglecting this salinity correction results in an error of
less than 1 %.

Table 2: Salinity Correction Constant at Different Temperatures

Temp (°C) K (1/ppt) Temp (°C) K (1/ppt) Temp (°C) K (1/ppt)

1 0.08796 11 0.06286 21 0.04854
2 0.08485 12 0.06104 22 0.04754
3 0.08184 13 0.05931 23 0.04662
4 0.07911 14 0.05757 24 0.0458
5 0.07646 15 0.05602 25 0.04498
6 0.07391 16 0.05456 26 0.04425
7 0.07135 17 0.05328 27 0.04361
8 0.06916 18 0.05201 28 0.04296
9 0.06697 19 0.05073

10 0.06478 20 0.04964

The data in Table 2 have been plotted and fitted to a third order polynomial as
shown in Figure 2:

k =-6.008E-07T3 + 7.343E-05T? - 3.307E-03T + 9.118E-02 (2)
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Using the temperature measured by the S132 temperature probe, k can be
calculated using equation (2). Using this calculated k and the salinity, S, measured
by the S130 salinity probe, Equation (1) provides the salinity correction for
dissolved oxygen measured by the DO probe. These calculations are performed by
Logger Pro to obtain the salinity corrected DO, DOcor, (which is temperature and
pressure compensated internally in the optical probe).

NOTE: the Q-Box AQUA package is designed for use with the salinity probe as the
DOcor values use salinity readings. If the salinity probe is not used, the readings
will not be correct and DO uncorrected should be used)

Figure 2: Salinity Correction Constant

Salinity Correction Constant (k) (1/ppt)
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Installing and Running Logger Pro 3

PC Users:

(1)

(2)
(3)
(4)

(5)

(6)
(7)

To start, you will need to have a complete copy of Logger Pro 3 installed on the computer.
Before starting the installation, make sure that all USB cables are disconnected from your
computer. Failure to do so may cause an error in the installation of the USB drivers.

Run the installation and do not change the default destination directory. Logger Pro 3 will
be installed in C:/Program Files/Vernier Software/Logger Pro 3.

The setup process will automatically load the USB drivers for connecting the LabQuest Minis
to your computer.

If you do not have QuickTime 6 (or greater) installed on your computer, it is advised that
you install it when prompted. QuickTime will allow you to use the picture and movie
features of Logger Pro 3.

You will be prompted to connect the LabQuest Minis to the computer via the USB
connection. Click ‘Finish’ to complete the installation process.

Proceed to C404 to obtain the “Q-Box AQUA Setup” file.

Double click the “Q-Box AQUA Setup” file (copied from Qubit Experiments folder of C404
disk to your computer) to start Logger Pro and data collection. If Logger Pro detects the
LabQuest Mini interfaces, the Logger Pro screen will appear with two LabQuest Mini icons
in the top left side

\

(9) If Logger Pro cannot detect the LabQuest Mini Interfaces, a message will appear “no

device connected”. Check that the LabQuest Minis are connected to the computer via
the USB cables, and that the USB cables are connected to the computer. Exit the Logger
Pro “Q-Box AQUA Setup” file, disconnect and reconnect these cables and restart the
Experiment File. Reconnect the USB cables with USB of Mini1 first then USB of Mini 2.
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Macintosh Users:

(1) To start, you will need to have a complete copy of Logger Pro 3 installed on the computer
(You must be using at least OS 9.2). Run the “Complete Installation” and make sure that
you have disconnected all TI GRAPH_LINK and USB cables. The most recent version of
Logger Pro (3) is included with this package. Following instructions are the same as for PC
users.

C404 Custom Experiment Files Installation:

Qubit Systems’ C404 Custom Setup Files CD contains experimental files associated with this
package, in this case “Q-Box AQUA Setup”. The C404 disk also contains a manual for this
package and the data interface (LabQuest Mini). These files can be copied to user specified
location on the computer and the experimental file “Q-Box-AQUA Setup” should be placed in
an accessible location or have a shortcut created on the desktop to the file. We highly
recommend for the user to make a copy of the original file and keep it in a safe place on the
computer in case the original is accidentally altered.

Using the S130 Salinity Probe

The salinity probe measures the electrical conductivity, C of a liquid in order to calculate its
salinity, S. It does this by measuring the current carried by ions between its two electrodes,
when a voltage is applied between the electrodes. It provides the total concentration of ions in
solution but does not identify the ions. It actually measures conductance (i.e. 1/resistance), G in
units of microsiemens, pS. The conductivity is calculated as:

C = G*kc (3)
where k. is the cell constant for the probe. The cell constant for the probe is:
ke = d/A (4)

where d is the electrode separation and A is the electrode area. For the S122 salinity probe,
the cell constant is:

ke=1cm/0.1 cm?2=10cm™?

To prevent electrolysis and polarization of the electrodes, an AC voltage rather than DC is
applied between the two electrodes. As shown in the figure below, the direction of ion flow is
reversed on each cycle of the applied AC voltage.
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There is a relationship between conductivity, C, (uS/cm) and concentration of a specific ion or
salt defined as salinity, S, measured in mg/L (ppm) or in parts per thousand (ppt = ppm/1000).
This relationship between conductivity and salinity depends on the ion as shown in Table 3. For
sodium chloride, the major salt in seawater, it is approximately a 2:1 ratio and is very nearly a

direct relationship:

C= ks*s (5)

Table3: Relationship Between Conductivity (uS/cm) and Salinity (mg/L) for Various lons

lon Conversion Constant, K (uS*L/(cm*mg))
Bicarbonate 0.715
Calcium 2.60
Carbonate 2.82
Chloride 2.14
Magnesium 3.82
Nitrate 1.15
Potassium 1.84
Sodium 2.13
Sulfate 1.54

In summary, the S130 salinity probe obtains the solution conductance, G, from the ionic current

between its two electrodes, then combining equations 3 and 5, calculates salinity, S as:

(6)
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When using the S130 salinity probe, ensure the electrodes are submerged. The handle is not
waterproof. Rinse and dry the probe tip with a tissue between measurements. The probe can
be stored dry after rinsing and drying.

The sensor may be recalibrated using a 2-pont calibration by clicking on
Experiment>Calibrate>LabQuest Mini: 1 CH2: Salinity and following the instructions. The zero
point can be obtained with the probe in air. The second point is obtained by placing the probe
in a standard saltwater calibration solution. A 35 ppt standard solution (equivalent to
seawater) can be prepared by adding 33.03 g of NaCl and adding distilled water to make 1 liter
of solution. Use reagent grade rather than iodized salt.

The salinity sensor has an internal thermistor to automatically compensate for temperature
changes between 5 and 35 °C. Readings are automatically referenced to a conductivity at 25 °C,
thus the sensor at other temperatures will give the same conductivity as if it were at 25 °C.
Therefore, the probe can be calibrated in the lab and used at other temperatures in the field.

Note that the Q-Box -AQUA package requires the use of the salinity probe to correct the DO
readings for changes in salinity. If a salinity probe is not used, the DOcor readings that are
displayed and used in calculations of VO2 will not be correct.

When using the salinity probe ensure that the probe is not fully submerged in the water. The
top of the probe with the cable should be kept above the water level to prevent damage to
the probe.

Using the S132 Temperature Probe

The temperature probe sensor is a semi-conductor device (20 kQ NTC thermistor) mounted on
the end of a stainless-steel probe. The handle is not waterproof so only the steel part should be
submerged. It has an operational range from —40°C to +135°C. The sensor can be placed in the
water bath for monitoring the temperature of the water in the system. It is suitable for
continuous use in saltwater. Do not fully submerge the temperature sensor in the water. The
top of the probe where the cable is attached should not be submerged to prevent water
damage.

The sensor is recognized automatically, and calibration is loaded when the “Q-Box AQUA Setup”
file is opened. The temperature sensor should not require calibration, however if necessary, it
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can be recalibrated (three point) in Logger Pro by clicking on Experiment>Calibrate>LabQuest
Mini: 1 CH3: Stainless Steel Temperature and following the instructions. The thermistor's
resistance, R decreases nonlinearly with increasing temperature as described by the Steinhart-
Hart equation:

T = [Ko + K1(In(L000R)) + Ko(In(1000R3)]t - 273.15 (6)

where T is the temperature (°C), R is the thermistor resistance (kQ), Ko=1.02119E3,
K1=2.22468E* and K3=1.33342E7. When connected to the LabQuest Mini interface, R is
measured, and T is calculated in Logger Pro using the above equation.

Using the $181 Absolute Pressure Sensor

The S181 is an absolute pressure sensor with a silicon-based electronic sensor. It measures
changes in pressure and produces a voltage output in the range of 0-2V that corresponds to
pressures of 15-115 kPa. This sensor is factory calibrated and only needs to be plugged into the
LabQuest Mini interface. The sensor is temperature-compensated and has a fast response time
(1ms). Do not submerge the sensor under water. It is designed for measurements of
atmospheric pressure only. The atmospheric pressure readings can be used when calibration the
DO probe in mg/L.

Using the PL175 Liquid Pump

The PL175 is a liquid pump that provides flows of water in the range of 0-1.4 L/min (no load).
When used with the Q-Box AQUA system, the resistance of all the components result in a
maximum flow of approximately 1 L/min. The speed of the pump can be regulated with the speed
control knob on the front of the instrument. The speed of the pump may also be monitored in
the software as Flow voltage output. This output is specific to each setup and should be corelated
with specific flow rates through the system. Connect the tubing from the outlet of the 3-way
valve to the “IN” port of the pump. When finished using the pump, disconnect all the tubing and
blow out any water that may be in the lines, before storing the pump in the Q-Box case. Please
note that when setting up the system the liquid pump may be turned upside down briefly to
release any bubbles that may get trapped inside.
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Using C200 Digital Control Unit DCU

The C200 Digital Control Unit works together with the A236 3-way liquid valve to change the flow of
water from Flush (when respirometer chamber is flushed with freshly oxygenated water) to
circulation, when decline in DO due to respiration of the animal is measured. The A236 valve is
plugged into D1 input on the DCU. When activated by the software the red LED light above D1 will
light up. When trouble shooting the A236 valve and the DCU, one may open the software and
check the settings by clicking on the first star (representing Mini 1) in the top menu.

File Edit Experiment Data Analyze Insert Options Page Help

[ B rawoea b 0 A L

/r-;"{- Dissolved Oxygen = 9.85 mg/L Salinity = 0.0 ppt Temperature = 18.0°C |-
[
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The following window will appear. Click on the Digital Control unit and select “Digital Out” from the

drop-down menu. /

A

The window below shows the DCU programing for the control of the 3-way solenoid valves. If this
programing has been changed the function of the system may be affected. Please ensure that the
correct programing is restored.

e
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Specifications

S$122 Optical DO Probe

Range: mg/ml

%
Accuracy: mg/L
%
Resolution:
Response Time:
Temperature compensation:
Pressure compensation:
Salinity compensation:
Stirring Required?

Stored calibration constants (mg/L): slope
intercept

Stored calibration constants (%): slope
intercept

Dimensions: probe tip diameter
probe tip length
probe handle length
length of cable

S$130 Salinity Sensor

Range:

Resolution:

Accuracy:

Response Time:
Temperature compensation:
Cell constant:

Electrodes:

Dimensions:

Calibration constants: slope
intercept

0 to 20 mg/L

0 to 100%

+/- 0.2 mg/L below 10 mg/L

+/- 0.4 mg/L above 10 mg/L

+/-2%

0.006 mg/L

90% of final reading in 40 sec

automatic from 0 to 50 °C

automatic from 228 mmHg to 1519 mmHg
externally corrected for in LoggerPro software
no

4.444 (mg/L)/V

-0.4444

22.222 %/V

-2.2222

16.6mm OD

100 mm

120 mm

1.36m

0 to 50 ppt (0 to 50,000 ppm)
0.02 ppt (20 ppm)

+/- 1% of full scale reading

98% of full scale reading in 5 sec
automatic from 5 to 35 °C
10cm?

parallel platinum

12 mm OD; 150 mm length

16.3 ppt/V

0
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S$132 Temperature Sensor

Range:
Resolution:

Accuracy:
Sensor:
Response time (for 90% change in reading)

Dimensions

S$181 Pressure Sensor

Sensor:

Response time:

Range:

Voltage Output:
Temperature compensated:

-40 to 135 °C(-40 to 275 °F)

0.17 °C (-40 to 0 °C)

0.03°C(0to 40 °C)

0.1 °C (40 to 100 °C)

0.25 °C (100 to 135 °C)
+/-0.2°Cat0°C; +/-0.5°Cat 10 °C
kQ NTC thermistor

10 sec (in water with stirring)

400 sec (in still air)

90 sec in moving air

Stainless steel body: length 10.5 cm; 4.0
mm diameter

monolithic silicon pressure sensor
1ms

15to 115 kPa

Oto2V

yes
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Qubit Systems Warranty Information

QUBIT warrants all its instruments to be free from defects in materials or workmanship for a
period of one year from the date of invoice/shipment from QUBIT.

If at any time within this warranty period the instrument does not function as warranted, return
it and QUBIT will repair or replace it at no charge. The customer is responsible for shipping and
insurance charges (for the full product value) to QUBIT. QUBIT is responsible for shipping and
insurance on return of the instrument to the customer.

No warranty will apply to any instrument that has been (i) modified, altered, or repaired by
persons unauthorized by QUBIT; (ii) subjected to misuse, negligence, or accident; (iii) connected,
installed, adjusted, or used otherwise than in accordance with the instructions supplied by
QUBIT.

The warranty is return-to-base only, and does not include on-site repair charges such as labour,
travel, or other expenses associated with the repair or installation of replacement parts at the
customer’s site.

QUBIT repairs or replaces the faulty instruments as quickly as possible; maximum time is one
month.

QUBIT will keep spare parts or their adequate substitutes for a period of at least five years.

Returned instruments must be packaged sufficiently so as not to assume any transit damage. If
damage is caused due to insufficient packaging, the instrument will be treated as an out-of-
warranty repair and charged as such.

QUBIT also offers out-of-warranty repairs. These are usually returned to the customer on a cash-
on-delivery basis.

Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the damage
that naturally and inevitably occurs as a result of normal use or aging even when an item is used
competently and with care and proper maintenance.
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Return Procedure

Before returning any instrument to QUBIT:

Please consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact
faulty and has not just been set up improperly.

Contact QUBIT before sending anything back. We will issue an RMA number and provide shipping
instructions. QUBIT will refuse any goods that are returned without an RMA number or which
are sent in a manner outside of QUBIT’S stipulations.

If you have encountered a program failure, we would need a printed copy of any faults you have
seen, including how to reproduce them. Include these in the return package along with your
mailing address.

Include a copy of the Invoice on which the product was shipped to you.
All returns must be shipped prepaid. Unpaid packages will not be accepted.
In case of questions contact QUBIT by

E-mail: info@qubitsystems.com, by phone: (01)-613 384-1977, or by fax: (01)-613 384- 9118.
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